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ENVIについて
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ENVI入門

ENVI概要
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ENVI: ENvironmental for Visualizing Images
✓ユーザフレンドリーなインターフェース
✓空間データの処理と解析をするソフトウエア
✓快適なハイパースペクトルの解析処理
✓大容量データのハンドリング
✓定評ある解析アルゴリズムを多数搭載
✓ワークフロー機能による簡易な画像処理



ENVI入門

ENVIのオプション機能
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モジュール名 内容

Atmospheric Correction マルチ・ハイパースペクトル画像の大気補正を行うモジュールです。画像
内の大気の影響を除去します。

DEM Extraction ステレオペア画像から標高データ（Digital Elevation Model）を抽出するモ
ジュールです。

Feature Extraction オブジェクト分類法のモジュールです。従来のピクセル値の統計から分類
する方法と異なり、ユーザの求めるオブジェクト（車、屋根、河川、湖
等）を画像から抽出します。
また、点群データ解析ツールであるENVI LiDAR ではこのモジュールを使用
することで建物、木、鉄塔などのオブジェクトを抽出することができます。

Feature Extractionモジュールによる道路の抽出
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ENVIのオプション機能
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モジュール名 内容

Photogrammetry 対応衛星画像からオルソモザイク画像を作成するためのモジュールです。
ステレオペア画像を使用することで3 次元点群データの生成も行うことが
できます。

NITF NITF データの読み込み、書き込みをサポートするモジュールです。

ENVI Crop Science 衛星画像やUAV / ドローンなどで取得したマルチスペクトル画像を用いて、
圃場の健康状態や作物の数量把握を簡単に行うためのモジュールです。

SARscape 合成開口レーダ（SAR）画像の解析処理を行うためのモジュールです。基
本的な処理や干渉解析に加え、追加のオプションを加えることで時系列解
析や偏波解析も行うことが出来ます。

Deep Learning TensorFlowを使用して深層学習モデルをトレーニングし、空間特性とスペ
クトル特性に基づいて画像内のフィーチャを特定します。（※動作には
ハードウェア要件あり）
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ENVIの利用事例:防災 -地形図の作成

長野県林業総合センターは、昨今の山地災害の被
害を減らすべく、土砂災害危険地発見のための地
形判読を容易に行うために新たな立体図法、長野
県型立体地形図=CS立体図を開発しました。ENVI 
LiDARを使用し、その地形図を作成する元となる
高解像度DEM （数値標高モデル：Digital Elevation 
Model）を大量な航空レーザ測量データから抽出
しています。

• CS立体図法とは、以下を算出・着色した図法。
-標高や傾斜、勾配変化を視覚情報から直感的に読み
取ることができます。

1. DEMから曲率（Curvature）と傾斜（Slope）を算出
2. 谷（凹）地形を青色

3. 尾根（凸）地形を赤色

4. 緩斜面を淡い色、急斜面を濃い色で段彩化
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CS立体図

出典： 長野県 林務部 

長野県森林整備加速化・林業再生協議会 路網部会,

『長野県型立体地形図=CS立体図』を用いた林内路網の路網配置検討手順 

P6, 2014年3月
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ENVIのリソース

ENVI Discussion

• ENVI Discussion は当社ホームページ上に設けられており、ユーザ同士が問題の討議や意見の交換が行えます。

• https://www.nv5geospatialsoftware.com/Support/Forums/aff/216

GitHub

• 米国本社によって管理・運営されているGitHub のページでは、ENVI の機能拡張に関する様々なコードが公開
されております。

• https://github.com/envi-idl
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https://www.nv5geospatialsoftware.com/Support/Forums/aff/216
https://github.com/envi-idl
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問い合わせ先

NV5 Geospatial 株式会社では、ENVI 及びその他の製品に関する技術サ
ポート、お客様の使用事例などの情報を提供しています。
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NV5 Geospatial 製品・サポート連絡先
E-mail：
support_jp@L3Harris.com
Home Page：
https://www.nv5geospatialsoftware.co.jp/

mailto:support_jp@L3harris.com
https://www.nv5geospatialsoftware.co.jp/


ENVIの起動とUI
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ENVIの起動方法
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Windows10 / 11
[Start Menu] > ENVI 5.7 > ENVI 5.7

Mac
/Applications/harris/ -> ENVI5.7のアイコンを選択

Linux
ターミナルから envi_rtコマンドを入力する
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ENVIインターフェースについて
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メニューバー
ツールバー

レイヤマネージャ

オーバービュー

カーソル値表示 プロセスバー

ツールボックス
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ENVIインターフェース: メニューバー

•ファイルを開く、編集、表示に関
するツールや、ウィンドウの分割
など、インターフェース及び、画
像の基本的な操作に必要な機能を
提供します。
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ENVIインターフェース: ツールバー

•ズームイン・アウトや、パン、アノテーション、ストレッチなど、表
示した画像に対して操作に関するツールをグラフィカルなアイコンで
提供します（詳細は後述します）。
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ENVIインターフェース: レイヤマネージャ

•インターフェースに表示されている画像の管理
を行います。

•チェックボックスをオン/オフする事で、表示/
非表示の設定を行います。

•ファイル名上で右クリックをすると、サブメ
ニューが表示され、表示の削除やRGBコンポ
ジットの変更などが行えます。

•レイヤーマネージャの[Overview]へチェックを
入れることで、画像全体を表示します。
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ENVIインターフェース:ツールボックス

• ENVI の解析機能がカテゴリごとに格納されています。検索機能が提供
されており、「Search the Toolbox」へキーワードを入力することで、
該当の機能がリスト表示されます。
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ENVIインターフェース:
カーソル値表示およびプロセスバー
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地図投影法を保持した画像上でマウスを移動させると、カーソルのある場
所のピクセルに対応した地図情報が表示されます。

プロセスバーは、処理の経過を表示しています。右側にあるバツマークを
クリックすると、処理はキャンセルされます。



ENVI入門

ENVI HELP

•指定のブラウザでENVIのHELP機能が起動します。
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一見してわかる通り、英語版のみが提供されている。
日本語でHELPを参照する方法は、大きく2通りある。
1. 日本語パッチを適用する
2. WebブラウザでDocumentation Centerにアクセスしアドオンで翻訳する
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ENVI HELP（日本語）

•特定のバージョンでは、ENVIの日本語パッチが提供されています
-現在最新の日本語パッチ提供バージョンは、ENVI5.6です。

-ENVI5.7では、将来的に日本語パッチが提供される予定です。

•日本語パッチを適用すると、表示されるHELPも弊社で翻訳した日本語
版のものになります

17
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DOCUMENTATION CENTER

• ENVIのHELP機能と同じ内容のものが本社のDocumentation Centerで提供され
ています。

• ブラウザによっては翻訳アドオンを適用することが可能なので、機械翻訳
によって大まかな意味を捉えるのであればこの方法が便利です。
- https://www.nv5geospatialsoftware.com/docs/home.html

18

https://www.nv5geospatialsoftware.com/docs/home.html


ENVIの操作
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環境の設定: PREFERENCE

• 使用するデータへのアクセスなどを容易に行うため、環境の設定を行います。

• ENVI では、ファイルの入出力ディレクトリをあらかじめ指定することで、デフォルトで
指定したディレクトリを表示することが可能です。

20
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環境の設定: PREFERENCE
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名称 機能

Input Directory 入力ファイルを指定する際に表示するインプットディレクトリの指定

Output Directory 出力ファイルを指定する際に表示するインプットディレクトリの指定

Temporary Directory 処理中に作成される、テンポラリファイルの保存先

Auxiliary File Directory 読み取り専用のDVD などからデータを読み込む際に、ヘッダファイルが
書き込めない場合の保存先

https://www.nv5geospatialsoftware.com/docs/Preferences.html#Director

https://www.nv5geospatialsoftware.com/docs/Preferences.html#Director
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ファイル読み込み

• ENVI にラスタデータの読み込み、表示を行います。

•この演習では、Copernicus Open Access Hubより入手したSentinel-2の
データを読み込み、表示を行います。

22
MTD_MSIL1C.xml
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MTD_MSIL1C.XMLについて

• Sentinel-2 データを入手したとき
に画像データと共に配布される
メタファイル

• このメタファイルには、画像撮
影時の情報やデータ処理施設で
使用されたデータ処理のパラ
メータが含まれています。

• ENVI ではこのメタファイルを直
接指定することで、ENVI ファイ
ルと同様に取り扱うことができ、
波長帯の情報や地理情報などを
合せて読み込むことが可能です。

23
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SENTINEL-2ミッションについて

• Sentinel-2ミッションは、植生、土地被覆、
環境モニタリングをサポートするために
開発された2つの衛星で構成されている。
- Sentinel-2A衛星は2015年6月23日にESAに
よって打ち上げられ、10日間の繰り返し周
期で太陽同期軌道で運用されている。2機目
の同じ衛星（Sentinel-2B）は2017年3月7日
に打ち上げられた。これらを合わせて、地
球のすべての地表、大きな島、内陸および
沿岸海域を5日ごとにカバーしている。

• Sentinel-2 Multispectral Instrument (MSI)は、
290kmの軌道幅に沿って可視近赤外
（VNIR）から短波長赤外（SWIR）までの
13のスペクトルバンドを取得する。 

https://sentinels.copernicus.eu/web/sentinel/us
er-guides/sentinel-2-msi/resolutions/spatial

24

Band 
Number

Central Wavelength 
(nm)

Bandwidth (nm)
Spatial Resolution 

(m)

1 443 20 60

2 490 65 10

3 560 35 10

4 665 30 10

5 705 15 20

6 740 15 20

7 783 20 20

8 842 115 10

8a 865 20 20

9 945 20 60

10 1375 30 60

11 1610 90 20

12 2190 180 20

※ENVI上では、異なる解像度のデータは別々のオブ
ジェクトとして読み込まれます。これは。後続の
Data Managerの演習で確認できます。

https://sentinels.copernicus.eu/web/sentinel/user-guides/sentinel-2-msi/resolutions/spatial
https://sentinels.copernicus.eu/web/sentinel/user-guides/sentinel-2-msi/resolutions/spatial
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VIEW METADATA

• データが開かれたら、レイヤマ
ネージャで右クリックしView 
Metadataを選択して詳細を確認
してみます。

• データのサイズや型、設定され
ている投影情報や波長情報が確
認できることがわかります。
- ENVIがサポートしている衛星のメ
タファイルを指定して画像を開い
た場合、ファイルに記載されてい
る投影情報や波長情報が併せて読
み込まれます。

-現在読み込まれているデータが、
実数（浮動小数点）、符号付もし
くは符合無しの整数型かどうかを
理解することは、データ解析をす
る上で重要になります。（詳しく
はBand Mathの演習で触れます）

25
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ディスプレイツール

ツールバーで提供されているツールを使用して、表示した画像に様々な
操作を行うことができます。

• Cursor Value
-十字が交差するポイントのピクセル値や緯度経度を確認できる

• Arbitrary Profile
-始点と終点を指定すると、その間のピクセル分布を確認できる

26

https://www.nv5geospatialsoftware.com/docs/DisplayTools.html

https://www.nv5geospatialsoftware.com/docs/DisplayTools.html
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3ボタン式マウスによる移動の簡略化: 
パン機能とズーム機能について

27

クリック

前後回転
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ストレッチの調整

•表示した画像に対して、ストレッチやコントラストなどを変更して、
画像を見やすくします。

•データを読み込んだ際にRGB コンポジットで表示されている画像があ
るので、その画像を使用して操作を行います。

28
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ストレッチとは？

29

各ピクセルの値分布を調整して
見やすくするための処理

暗く見える 明るく見える

各ピクセルには様々な値が入っており、上に示すような分布だとします。
（値の取る範囲は、データがどのような型を持つかに依ります。詳細は後述します。）

0 65535
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ストレッチとは？
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各ピクセルの値分布を調整して
見やすくするための処理

暗く見える 明るく見える

まずはENVIで表示するにあたって、データ値を輝度値(0から255のBYTE値)に変換します
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ストレッチとは？
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各ピクセルの値分布を調整して
見やすくするための処理

暗く見える 明るく見える

全体的に暗いので、
この辺りで見え方を
調整し直したい
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ストレッチとは？
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各ピクセルの値分布を調整して
見やすくするための処理

暗く見える 明るく見える

この辺りで見え方を
調整し直したい
この範囲で明るさを
再度調整した
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ストレッチとは？

33

各ピクセルの値分布を調整して
見やすくするための処理

暗く見える 明るく見える

この辺りで見え方を
調整し直したい
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ストレッチとは？

34

各ピクセルの値分布を調整して
見やすくするための処理

暗く見える 明るく見える

この辺りで見え方を
調整し直したい
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ストレッチの実施

ENVIのストレッチ機能には、変換方法が幾つか用意されています
• ここではOptimized LinearからGaussianに変更します
• その他のストレッチ手法について:

- https://www.nv5geospatialsoftware.com/docs/BackgroundStretchTypes.html

35
Optimized Linear Gaussian

https://www.nv5geospatialsoftware.com/docs/BackgroundStretchTypes.html
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ストレッチの実施（VIEWエリアで最適化）

1.  ボタンで全体を表示し、     
ボタンで富士山頂を拡

大します

2.      ボタンで、表示したエ
リアについてストレッチを
適用します

3.  ボタンをクリックして
拡大/縮小による自動更新
を有効に設定します

4.      ボタンで、全体に対し
て再度ストレッチを実施し
ます

36

Stretch on View Extent
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補足: ヒストグラムストレッチ

•ストレッチしたい範囲をユーザ側で任意に決めるには、ヒストグラム
ストレッチという機能を使用します

37https://www.nv5geospatialsoftware.com/docs/displaytools.html#InteractiveStretching

https://www.nv5geospatialsoftware.com/docs/displaytools.html#InteractiveStretching
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データマネージャ

Data Manager は読み込んだファイルを管理しています。

• レイヤーマネージャでは、表示している画像の情報しか表示されません。

• データの詳細情報を確認する時や、すでに読み込んだデータを別の表現(バンドのグレイスケール
表示や、RGB コンポジットの変更など)で表示する際にこのマネージャを使用します。

• https://www.nv5geospatialsoftware.com/docs/OpeningLocalFiles.html#OpenDataManager

38

OPEN

https://www.nv5geospatialsoftware.com/docs/OpeningLocalFiles.html#OpenDataManager
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データマネージャ: 演習

1. メニュー → File → Data 
Manager を選択してください。

2. Data Manager ダイアログ → 
「10m-S2MSI1C 2020-05-02 
01:27 T54STE」の[Band 8]を右
クリック → Load Grayscale を
選択してください。
-ここでみてわかる通り、ENVIでは同
じSentinel-2のデータであっても、
異なる解像度のデータを別々のオブ
ジェクトとして管理しています。

3. Band 8 が表示され、レイヤー
マネージャへ追加されているこ
とを確認してください。

39
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カラーの変更

前の項目で表示したBand8 のグレイスケールの画像に対して疑似カ
ラーを付与します。

•グレイスケールの画像には、カラーテーブルを割り当てることで、
データの分布を一目で確認することが可能です。

•疑似カラーを付与する機能として、「Change Color Table」と「Raster 
Color Slices」のツールがあります。

40
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CHANGE COLOR TABLE

1. レイヤーマネージャ → グレ
イスケール画像の「10m-
S2MSI1C 2020-05-02 01:27 
T54STE」を右クリック → 
Change Color Table →Rainbow 
を選択します。

2. カラーテーブルを選択すると、
選択したカラーテーブルによ
り色づけされた画像がディス
プレイに表示されます。

適用している疑似カラーは、
データの実際の各ピクセル値に
対してではなく、ストレッチさ
れた後の見え方に対して適用さ
れています。

• ストレッチを変更すると、色の
当たり方が変わることを確認し
てください

41
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RASTER COLOR SLICE

1. レイヤーマネージャ → グレイス
ケール画像の「10m-S2MSI1C 
2020-05-02 01:27 T54STE」を右
クリック → New Raster Color 
Slice を選択します。

2. Data Selectionウィンドウが出現
するので、B8を選択します。

3. Edit Raster Color Slicesウィンドウ
の設定を確認し、OKボタンで閉
じます。

このカラーは、実際のピクセル値に
対して適用されています。
• ストレッチの変更自体が不可能で
あることを確認してください。

42
https://www.nv5geospatialsoftware.com/docs/ColorSlices.
html

https://www.nv5geospatialsoftware.com/docs/ColorSlices.html
https://www.nv5geospatialsoftware.com/docs/ColorSlices.html
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RGBコンポジット: 背景

• 衛星は、光源(太陽)からの電磁波が地表面の物質を反射してセンサに戻って
くる強さ(電磁波の強さ)を観測します。
-地表面の物質は、それぞれ違った反射の特徴があり、衛星の各バンドは波長帯域が違
う電磁波を取得することから、地表面の反射の特徴をとらえることができます。

• これを利用し、RGB へ割り当てるバンドを変更することで、地表面の特徴
を一目で認識できるように表示します。
-以下の図は、各波長帯における地表面の物質(植物、土、水)の電磁波の反射と放射の
強さを示しており、横軸は電磁波の波長を、縦軸は反射・放射の強度を示します。

43
各波長帯における植物、土、水の電磁波の反射と放射の強さ[JAXA]
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RGBコンポジット: トゥルーカラー合成

• 衛星データは様々な波長帯で収集
されている。

• 個々のデータはシングルバンドの
グレースケール・データであるが、
ENVIはそれらにRGBの色を付加し、
合成として表示することができる。

• 青色波長帯で取得されたデータに
は青色チャンネルを、緑色波長帯
で取得されたデータには緑色チャ
ンネルを、赤色波長帯で取得され
たデータには赤色チャンネルを適
用することで、人間の目で見たよ
うな画像を作成することができま
す。
-これをトゥルーカラー合成という。

44

IKONOS, JSI
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RGBコンポジット: フォールスカラー合成

• 同様に、カラー合成を適切なものに変更
することで、特定の波長における反射の
強さを強調することができる。

• 緑色の波長帯で取得したデータに青色の
チャンネルを、赤色の波長帯で取得した
データに緑色のチャンネルを、近赤外線
の波長帯で取得したデータに赤色のチャ
ンネルを適用すると、植生が強調された
画像が得られる。
-これをフォールスカラー合成と呼ぶ

-これは植生が近赤外域で強い反射特性を持
つことを利用している
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ENVI入門

RGBコンポジット：演習

1. メインメニュー →File → Data Manager を選択
します。

2. Data Manager ダイアログ → [RGB に該当する
Band を選択] → Band Selectionタグを展開し、
RGB コンポジットを確認します。 

3. 組み合わせが決まったら、「Load Data」ボタ
ンをクリックして画像を表示してください。
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演習ではフォールスカラーを作成する

青: Band3 / 緑: Band4 / 赤: Band8



ENVI入門

データの比較

作成されたフォールスカラー画像と、トゥ
ルーカラー画像を比較します。

•レイヤマネージャのShow/Hideチェックを切
り替える

•透過率を変更したいレイヤをレイヤマネー
ジャで左クリックした後、ツールバーの
Transparencyバーを変更する

• Viewを分割し、互いにリンクさせる（後述）
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透過率0%

透過率100%



ENVI入門

複数のビューと画像のリンク

• ENVI のインターフェースでは、複数のビューを用いて同時に画像を表示し、リンクする
ことができます。

• 画像をリンクさせることで、表示しているデータを効率的に比較します。
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ENVI入門

複数のビューと画像のリンク: 演習

1. メニュー → Views → Create New View を選択し、画像の表示エリアが二つに分割されたことを確認してく
ださい。

2. レイヤーマネージャ → 新しく作成されたView をクリックしてください。

3. Data Manager → Band4 を右クリック → Load Grayscale を選択してください。
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現在アクティブなビューは
緑色の枠で囲われていることから区別できる



ENVI入門

複数のビューと画像のリンク: 演習

4. 新しく作成されたView の[Overview]へチェックを入れ、画像全体も確認してください。この時点
では画像はリンクされていないため別の場所を表示しています。

5. View → Link Views を選択し、表示した二枚の画像のリンクを行います。

6. Link Views ダイアログ → <Link ALL> → <OK> をクリックし、リンクを実行し、比較します。
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この演習では地理情報を利用して
リンクを行う[Geo Link]を選択します。
ピクセルポジションを利用し
リンクを行う場合は、
[Pixel Link]を選択してください。



ENVI入門

画像を閉じる

•表示している画像を閉じ、必要がなく
なったView を閉じることが出来ます。
-個々のレイヤはレイヤを右クリックし、

Removeで閉じます

-Viewを削除する場合はViewを右クリック
し、Remove Viewを選択します

-Viewは残したまま、Viewにあるレイヤを
削除するには Remove All Layersを選択し
ます。
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✓ Layer Managerから削除してもData Managerにはデータが残ります。
✓ 必要のないファイルを閉じる場合は、Data Manager から該当ファイ
ルを右クリック → Close File を選択してください。



ENVIによる解析
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ENVI入門

キャリブレーション

• 一般に配布されているデータは反射された光の強さが記録されています。
-この状態で記録されている値を、デジタルナンバーと呼びます。

• デジタルナンバーは変換係数を使用して放射輝度や反射率といった物理量
に変換することができます。
-この操作をキャリブレーションと呼びます
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デジタルナンバー 反射率などの物理量

⚫ ENVIがこのキャリブレーションをサポートする衛星は以下にまとめられています。
⚫ https://www.nv5geospatialsoftware.com/docs/RadiometricCalibration.html

⚫ この他にも、プログラムによって独自のキャリブレーションを追加することも可能です。

https://www.nv5geospatialsoftware.com/docs/RadiometricCalibration.html


ENVI入門

キャリブレーション: 演習

1. ツールボックスの検索フィールドへ「radio」と入力しRadiometric 
Calibration をダブルクリックして起動させてください。

2. Input RasterのBrowseボタンを押下し、ファイル選択ダイアログで
「 10m-S2MSI1C 2020-05-02 01:27 T54STE 」を選択し、 <Spatial 
Subset>をクリックしてください。

3. Spatial Subset ダイアログでは、画像の処理範囲を設定します。以下の
パラメータを入力し、<OK>をクリックしてください。

4. Input Rasterに[Subset]と付加されたデータが登録されることを確認して
ください。
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Columns: from 6000 to 9999 
Rows: from 6000 to 9999



ENVI入門

キャリブレーション: 演習

5. 以下のパラメータ設定に更新し、OK
ボタンでファイル出力してください。

6. Cursor valueツールを使用し、出力さ
れた結果のピクセル値が0.0から1.0
の間で登録されていることを確認し
てください。
-反射率は0.0から1.0で定義された光の反射
の強さを示す物理量です。
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Calibration Type: Top-of-Atmospheric 
Reflectance
Scale Factor: 1.0
Output Data Type: Float
出力ファイル名: ref.dat



ENVI入門

出力ファイルの確認: ENVI形式とは

ENVI フォーマット(ENVI から作成されるファイル)は、単純なラスタフォーマットのデータです。

• このフォーマットはバイト型で形成され、フラットバイナリファイルと呼ばれるデータフォー
マットです。

• このフォーマットは画像以外のデータが含まれないため、ENVI はENVI ヘッダファイル（ENVI 
Header File：*.hdr）というASCII ファイルを作成し、そこに画像を読み込むためのパラメータ情報
を記録します。
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• 拡張子なしまたは.dat形式のフラットバイナリデータ
• .hdr形式の関連情報を書き込んだASCIIファイル

【ENVIフォーマットの構成要素】

フラットバイナリデータ

ASCII ファイル



ENVI入門

大気補正

• 衛星センサは大気を通して地表を観測しているため、大気中の水蒸気や細かい粒
子の影響を受けています。

• 衛星画像データを定量的に解析するためには、この大気効果を除去して真の地表
反射率を求めることが必要です。
-ここでは、ENVI の標準機能に含まれている散乱や、もやの影響を除去する「Dark 

Subtraction」という手法を使用し、大気の影響を簡易的に除去する補正を行います。
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デジタルナンバー

反射率などの物理量

大気効果を除去した真の物理量

キャリブレーション

大気補正



ENVI入門

大気補正: 演習

1. ツールボックスの検索フィールドへ「dark」と入力しDark 
Subtraction を選択してください。

2. ファイルの選択ダイアログでは、「ref.dat」を選択します。
Dark Subtraction のパラメータ設定ウィンドウでは、以下の
設定を行って下さい。

3. 処理終了後、レイヤーマネージャへ「dark.dat」が追加され
ていることを確認してください。
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Subtraction Method: Band Minimum
Output Result to: File
Enter Output Filename: dark.dat

 ダークサブトラクションとは、各バンドから指定した値を一律で差し引くという手法です。
 これは、本来反射がないと考えられる部分(陰)からオフセットを計算しています。
 差し引く値にバンド毎の最小値を指定すると、処理の結果各バンドの最小値が0になりま
す(Band Minimum)。



ENVI入門

大気補正: 演習

4. 処理前の画像「ref.dat」と大気補正後の画像「dark.dat」のスペクトルの
違いを確認します。Spectral Profileツールを選択し    Options → Additional 
Profiles → Add File で「ref.dat」を選択して追加を行ってください。
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Dark Subtractionによって各バンドの最小値が0になるように減算さ
れているため、darkのほうがrefよりも値が低い



ENVI入門

RADIOMETRIC CORRECTION ツール

• ENVI に標準機能に含まれる、キャリブレー
ションや大気補正のツールはENVI ツールボッ
クスの「Radiometric Correction」フォルダに
含まれます。
-Dark Subtraction

-Flat Field

-Empirical Line

- Internal Average Reflectance

•一般的に大気補正は、研究所やフィールドよ
り得られたグランドトルースのスペクトル
データに基づいて計算されます。
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https://www.nv5geospatialsoftware.com/docs/atmosphericcorrection.html

https://www.nv5geospatialsoftware.com/docs/atmosphericcorrection.html


ENVI入門

ATMOSPHERIC CORRECTION: 大気補正モジュール

大気補正に関する追加機能を提供するオプションモジュール

FLAASH

• Spectral Sciences, Inc.  (SSI)、Air Force Research Labs  (AFRL)および米国本社の3社で開発された、MODTRAN6
ベースの大気補正ツールです。

• スペクトルの水分吸収帯の情報から水蒸気量を算定し、反射率に変換します。

• ENVI5.7から大幅なアップデートが行われ、UIが更新されました。

QUAC

• マルチバンド（ハイパースペクトルも含む）、大気補正を簡易的におこなうツールです。

• 放射輝度への変換などの前処理が必要ないため、操作が簡単です。

• 高解像度のマルチバンド画像においてよく使用されています。
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https://www.nv5geospatialsoftware.com/docs/AboutAtmosphericCorrectionModule.html

https://www.nv5geospatialsoftware.com/docs/AboutAtmosphericCorrectionModule.html


ENVI入門

BAND MATH

• 同じファイルのバンド間で演算を行い、新たなファイルを作成します。

• 一般的に知られている数式や係数を与えることで、NDVI（植生指標）など、リ
モートセンシング画像を解析する上で便利な解析結果を求めることが可能です。
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赤色波長で取得したイメージ

近赤外波長で取得したイメージ

NDVI

✓ NDVI は植生の分布状況や、活性度を示す
指標で、-1 から1 の範囲で表されます。

✓ 植生の反応が高い場合は1 に近く、低い場
合は-1 に近い値となります。



ENVI入門

BAND MATH: 演習

1. 大気補正結果である「dark.dat」が開かれていることを
確認します。

2. ツールボックス → 検索フィールドへ「band」と入力し
てください → Band Math を選択し、起動させてくだ
さい。

3. Band Math ダイアログが表示されます。Enter an 
expression へ以下の式を入力 → <Add to List>をクリック 
→ <OK>をクリックしてください。
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(fl𝑜𝑎𝑡 𝑏8 − 𝑏4)/(float(𝑏8) + 𝑏4)

✓ 使用する変数はb始まりで定義します

✓ 型は一番大きいものに併せて計算されるため、元のデータ型に応じて型変換
(キャスト)することが必要です。

• 整数しか扱えないBYTEやINTEGERでは、商に含まれる小数点以下が切り
捨てられることがあります。

• 例えば0から255からしか扱えないBYTE型では、和差積がこの範囲から外
れると、値が壊れます。



ENVI入門

BAND MATH: 演習

4. Variable to Bands Pairings ダイアログが表示されます。
変数、B4 とB8 にどのファイルのバンドを使用する
か設定を行います。

5. Variable used in expression フィールドのB4 に
「dark.dat」の664μmで取得されたB4由来のバンド
を選択してください。

6. Variable used in expression フィールドのB8 に
「dark.dat」の832μmで取得されたB8由来のバンド
を選択してください。

7. Output Result to を「File」にし、ファイル名を
「ndvi.dat」に設定し、「OK」ボタンをクリックし
て処理を実行してください。

8. 表示された結果のピクセル値が-1.0から1.0で定義さ
れており、植生の多い場所で1に近いことをCursor 
Valueツール等で確認してください。
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ENVI入門

BAND MATH: 補足

• 本処理では、演習のためNDVIの算出は手動で行い
ましたが、ENVI にはツールボックスのSpectral → 
Vegetation フォルダ内に簡単にNDVI を算出する
ツールが用意されています。
- https://www.nv5geospatialsoftware.com/docs/NDVI.html

• そのほか、Band Algebra→Spectral Indicesでは複数
の指標演算の計算をサポートしています。
- https://www.nv5geospatialsoftware.com/docs/spectralindi

ces.html

• ENVIがサポートする指標演算の一覧は以下から確
認できます。
- https://www.nv5geospatialsoftware.com/docs/alphabetica

llistspectralindices.html
-ここに含まれていないものや、独自の指標を計算する場
合にはBAND MATHツールを使用します。
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Spectral Indicesツール

https://www.nv5geospatialsoftware.com/docs/NDVI.html
https://www.nv5geospatialsoftware.com/docs/spectralindices.html
https://www.nv5geospatialsoftware.com/docs/spectralindices.html
https://www.nv5geospatialsoftware.com/docs/alphabeticallistspectralindices.html
https://www.nv5geospatialsoftware.com/docs/alphabeticallistspectralindices.html


ENVI入門

TIFF形式への変換

これまでの処理ではENVI形式のファイルが出力されていました。

別の画像処理ソフトやプログラミング言語などで扱えるGeoTiff形式に変換する方法を紹介します。

1. メニュー → File → Save As → Save As…(ENVI, NITF, TIFF, DTED)を選択してください。

2. Select Input File ダイアログ → 「ndvi.dat」を選択 → <OK>をクリックしてください。

3. Save File As Parameters でファイル形式を[TIFF] → 出力ファイル名に「ndvi.tif」を設定 → <OK>
をクリックしてください。

4. 出力ファイルがレイヤーマネージャへ追加されたことを確認してください。
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ENVI入門

レイヤスタック

• Sentinel-2やLandsat-8のような解像度の異
なるデータは、ENVIで読み込んだ際にそれ
ぞれ別のバンドグループで管理されます。

• これらのデータをまとめて一つのラスタ
データとして扱うためにはレイヤスタック
機能を使用します。
- https://www.nv5geospatialsoftware.com/docs/La

yerStacking.html

-こうすることで、たとえばSentinel-2で、
MNDWI(修正正規化水指数)のような緑(Band3: 
10m解像度)と短波赤外(Band11: 20m解像度)の
波長帯を使用した指標値計算がBand Mathツー
ルなどから行えるようになります。
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https://www.nv5geospatialsoftware.com/docs/LayerStacking.html
https://www.nv5geospatialsoftware.com/docs/LayerStacking.html


ENVI入門

レイヤスタック: 演習

1. ツールボックスのRaster Management/Build Layer Stack
を選択し、起動させてください。

2. Build Layer Stackダイアログが表示されます。以下の設
定を入力し、OKボタンで処理を実行してください。

3. Data ManagerやView Metadataで結果のメタ情報を確認
してください。
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✓ Input Rastersには10m, 20mおよび60mのSentinel-2データをそれぞれ設定し
ます。順番は先頭に10mのものが来るように設定して下さい。

✓ Grid Definitionは先頭データに依存します。明示的に10mになるようにFrom 
Datasetボタン        から10mのデータのメタ情報で登録してください。

✓ Resampling処理はデフォルトのNearest Neighborのままとします

✓ Output RasterはFileボタンに出力設定を併せ、ファイル名は「stacked.dat」
とします。



ENVI入門

機能紹介: TEMPORAL DATA CUBE ツール

ENVI 5.6.3からTemporal Data Cubeという機能が追加されました。

• 同じ地域の異なる日付/時刻を表すバンドで構成されたラスタを構築することができるツールです。

• このツールの出力結果は、特定のエリアの時系列的な変化に注目した処理への利用が期待されま
す。

• https://www.nv5geospatialsoftware.com/docs/WorkingWithTemporalCubes.html
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https://www.nv5geospatialsoftware.com/docs/WorkingWithTemporalCubes.html


ENVI入門

機能紹介: ENVI MODELER

ENVI Modeler はビジュアルプログラミングツールです。

• この機能を使用することで、プログラミングするこ
となしにバッチ処理やカスタムワークフローを組み
立てて実行することが可能です。

• ここまでで使用してきた個々のツールを組み合わせ、
一連の処理としてひとつにまとめ上げることが可能
です。

• 作成した機能はENVIのツールボックスに追加するこ
とができます。また、ENVIの作成元であるプログラ
ミング言語のIDLや、Pythonといった言語のソース
コードとして出力することが可能です。

https://www.nv5geospatialsoftware.com/docs/VisualProg
rammingENVIModeler.html
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https://www.l3harrisgeospatial.com/docs/VisualProgrammingENVIModeler.html
https://www.l3harrisgeospatial.com/docs/VisualProgrammingENVIModeler.html


ワークフロー①: 分類処理
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ENVI入門

ワークフロー

• ENVIは、操作ガイドに従って進めるだけで簡単に解析結果を導くことができる
ワークフロー機能を多数搭載しています。
-画像処理の専門知識が無くても、科学的根拠に基づいた解析結果を手軽に得ることができます。

• ワークフローに搭載されているプレビュー機能を利用することにより、データ全
体へ解析処理を施す前に、設定したパラメータに基づく解析結果を部分的に表示
できます。
-パラメータの再調整などを行えるので、大容量のデータでも一度の処理で最適な解析結果を得
ることが可能になります。
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ENVI入門

分類処理

• ENVIでは、教師付き・教師なし分類を行うためのワークフローが用意され
ています。
-この演習では教師付き分類を使用してENVIのワークフローを体験します。
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教師付き分類

入力データと分類ラベルを

セットで与えて分類させる方法

教師なし分類

入力データだけを設定して

自動的に分類させる方法

水域

植生

裸地

自動で5通りに分類して



ENVI入門

分類処理: 演習

1. ツールボックス → 検索フィールドへ
「class」と入力してください → Classification 
Workflow を選択し、起動させてください。

2. File Selection ダイアログが表示されます。
<Browse>をクリック → 「dark.dat」を選択 → 
<OK>をクリックしてください。File Selection 
ダイアログの<Next>をクリックし、次の手順
へと進んでください。

3. Classification Type ダイアログでは、[Use 
Training Data]を選択してください。No Training 
Data は教師なし分類を実施します。
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ENVI入門

補足:トレーニングデータの作成方法

ポリゴンROI を使用してトレーニングデータを作成します。クリックで
3つ以上の頂点を作成し、ポリゴンを確定する際は、右クリックのメ
ニューからComplete and Accept Polygon を選択してください。
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左クリック

左クリック

左クリック

適当なところで右クリックし、
Complete and Accept Polygon を選択

✓ 押し間違えたなどの理由で
操作をやり直したいの場合
には、Clear Polygonを選択し
ます。

✓ 一度Acceptされたポリゴンは、
ワークフローのなかでキャ
ンセルすることはできませ
ん。やり直すためには、改
めてClassから作り直す必要
があります。

注意



ENVI入門

分類処理: 演習

4. Define Training Data ダイアログでは、ポリゴンを使用してトレーニング
データを作成します。ポリゴンを作成するトレーニングデータを選択し、
マウスカーソルが十字になっていることを確認してください。
✓veg (植生)、city (街)、snow (雪)、soil (土壌)、water(水域)のトレーニングデータを画像
から取得してください（ここでは、各データごとに3ポリゴンずつ作成してみます）。

✓プロパティでは、トレーニングデータの色の指定と名前の変更が行えます。
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新たなクラスはここから
追加できます

クラス名はここで変更し、
Enterキーで確定できます。
(注意)
日本語といったマルチバイ
ト文字は、クラス名に使用
しないでください。



ENVI入門

分類処理: PREVIEWとALGORITHMタブについて

• Previewを使用することで、分類処理
の結果を一部表示することができま
す。
-結果を見ながら、教師データを取り直す
などの処理が可能です。

- Preview範囲が広いと計算できないので、
ズームインして範囲を狭くして下さい。

• Algorithmタブからは別のアルゴリズ
ムやパラメータ変更を行うことが可
能です。
-選択可能なアルゴリズムの背景について
は以下のURLをご参照ください

- https://www.nv5geospatialsoftware.com/d
ocs/Classification.html#ClassSupervised
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https://www.nv5geospatialsoftware.com/docs/Classification.html#ClassSupervised
https://www.nv5geospatialsoftware.com/docs/Classification.html#ClassSupervised


ENVI入門

分類処理: 演習

5. Refine Results ダイアログで
は、ノイズ除去を行います。
✓スムージングの値とアグリゲー
ションの値を調整し、ノイズの
ように細かく分類された箇所が
無くなるように調整してくださ
い（ここではデフォルトの値で
進めます）。

✓[Preview]へチェックを入れるこ
とで、処理の結果をその場で確
認することが可能です。調整が
終了しましたら、<Next>をク
リックしてください。
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ENVI入門

分類処理: 演習

6. Save Result ダイアログでは、処理結果のラスタ及びベクタデータの
出力先を指定します。チェックがついているものは出力されます。
出力先と出力ファイル名を確認後、<Finish>をクリックしてくださ
い。

7. 処理が完了し、レイヤーマネージャにこれらの結果が追加されてい
ることを確認してください。
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項目 指定パス

Export Classification Image C:¥training¥output¥dark_class.dat

Export Classification Vectors C:¥training¥output¥dark_vectors.shp



ENVI入門

分類画像に対する後処理

•出力結果は、「クラス画像」と呼ばれる
分類データです。

• ENVIツールボックスの Classification > 
Post Classification配下には、こうした分
類結果に対する様々な処理がまとめられ
ています。

•分類結果に対して修正を加えたり、分類
結果を使用して分類元データに対して統
計処理を実施することが可能です。
-ここでは、統計処理のやり方を確認します。
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ENVI入門

クラス統計: 演習

1. ツールボックス Classification→Post Classification配下
の「Class Statistics」を選択し、起動させてください。

2. Classification Inputダイアログが表示されます。クラ
ス画像をインプットする箇所ですので、
「dark_class.dat」を選択し、OKボタンで先に進みま
す。

3. Statistics Input Fileダイアログが表示されます。クラ
ス画像と重ねて実際に統計値を算出するデータをイ
ンプットする箇所ですので、クラス画像の作成元に
なった「dark.dat」を選択し、OKボタンで先に進み
ます。

4. 統計を取るクラスを選択するClass Selectionダイアロ
グが出現します。Unclassified以外をCtrlやShiftキーを
使用して選択し、OKボタンを押してください。
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ENVI入門

クラス統計: 演習

5. Compute Statistics Parametersダイアログが出現しま
す。基本統計以外にも、ヒストグラムなども算出可
能です。

6. Output to the Screenにチェックが入っていることを
確認してOKボタンで実行します。

7. 結果がスクリーンに出力されます。
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ENVI入門

クラス統計: 結果の確認
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作図する対象は
Select Plotで変更できます。
結果を画像保存するには
Exportボタンを選択します。

下部の表は
Select All        を選択し
その後Copy        すれば
クリップボードに
コピーされます。
結果をExcelなどに貼り付けて
任意の作図を行うことも
可能です。



ワークフロー②: 差分抽出
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ENVI入門

差分抽出

• 2017年に発生したペルーの洪水災害を対象として差分抽出を行います。

•このインプットデータはSentinel-2の災害前後データをそれぞれBuild 
Layer Stackツールでまとめたものを使用します。
-同様のデータの入手方法については対応するチュートリアルページを参照くだ
さい。
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データ ファイルパス

2017年2月20日撮影 
Sentinel-2データ

changeDetection¥MalaRiver_2017-02-20.dat

2017年3月12日撮影 
Sentinel-2データ

changeDetection¥MalaRiver_2017-03-12.dat

2017年3月17日、ペルー・リマ市フアチパ地区で発生した大規模
な地滑りと洪水後の空撮映像(出展: The Atlantic)
https://www.theatlantic.com/photo/2017/03/peru-suffers-worst-
flooding-in-decades/520146/

https://www.theatlantic.com/photo/2017/03/peru-suffers-worst-flooding-in-decades/520146/
https://www.theatlantic.com/photo/2017/03/peru-suffers-worst-flooding-in-decades/520146/


ENVI入門

差分抽出: 演習

1. MalaRiver_2017-02-20.datとMalaRiver_2017-
03-12.datのデータを開いてください。

2. ツールボックス → 検索フィールドへ
「change」と入力してください → Change 
Detection Workflow を選択し、起動してくだ
さい。

3. Select Dataパネルでは、Input Raster 1に2/20
のデータを、 Input Raster 2に3/12のデータ
をそれぞれ設定してください。

4. [Next >>]ボタンを押して次の工程に進みます。
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ENVI入門

差分抽出: 演習

5. Image Registration パネルでは、2枚の画像の位置合わせを行うこと
ができます。すでに位置合わせされているならば、skip Image 
Registrationを選択します。ここでは、ペアは位置合わせ済みのため、
この工程はSkipします。
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この位置合わせの工程はデフォルトのパ
ラメータ設定に基づいて実行されます。
もし細かいパラメータ設定の行ったうえ
で位置合わせ処理を実行したい場合には、
Image Registration Workflowという、それに
特化した専用のツールをご利用ください。



ENVI入門

差分抽出: 演習

6. 次のCalculate Changeパネルでは、いくつかの
手法の中から適用するものを選択できます。
ここでは、バンド値の変化量に注目する
[Band Difference]を選択します。

7. どのバンドの変化注目するかについては、
Select Band を変更します。ここでは、
1613nmで取得された[B11 SWIR]を選択して
ください。
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Sentinel-2 Band

B2 Blue (496.6 nm)

B3 Green (560.0 nm)

B4 Red (664.5 nm)

B5 Vegetation Red Edge (835.1 nm)

B6 Vegetation Red Edge (703.9 nm)

B7 Vegetation Red Edge (740.2 nm)

B8 NIR (782.5 nm)

B8A Narrow NIR (864.8 nm)

B11 SWIR (1613.7 nm)

B12 SWIR (2202.4 nm)

洪水流には土砂や泥が含まれており、それらは短波赤外線
（SWIR）バンドによく写ります。B11のSWIRバンドを使用し
て差分画像を作成することで、この変化を抽出します。



ENVI入門

差分抽出: 演習

8. Thresholdパネルでは、一定の値以上の変化量だけを抽出するためのしきい値が設定できます。
画像内の黒い領域は、関心のない領域としてマスクされます。デフォルト設定のままNextで先に
進めます。

9. Vectorize Changesパネルでは、変化したエリアの周囲でポリゴンを作成する方法について定義し
ます。
- Minimum Pixelには、考慮する奇数を指定します。この値よりもピクセル数が少ない領域は、出力シェープファ
イルで破棄されます。最小値は 0 ピクセル、デフォルト値は3です。

- 平滑化のためのSmooth Kernel Sizeには、奇数を指定します。最小値は 0 ピクセル (平滑化なし)、デフォルト値
は3です。
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ENVI入門

差分抽出: 演習

10. 最終工程のExport Resultsパネルでは、出力するファイルを選
択できます。Classification RasterおよびShapefileに適当なファ
イル名を設定して、Finishで処理を完了させてください。
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ENVI入門

その他のワークフロー:
位置合わせ(IMAGE REGISTRATION)

• 差分抽出ワークフローのなかで
行える位置合わせの工程は、よ
り詳細なパラメータ設定ができ
るImage Registration Workflowと
して独立しています。

• ツールの中では自動取得された
タイポイントを手動で追加・調
整することができるため、より
厳密に位置合わせが求められる
ケースでは、このツールが有効
な場合があります。

91



ENVI入門

拡張機能の紹介

ENVIでは、IDLやENVI Modelerによって作成したオリジナルの機能やバッチ処
理をENVIツールボックスに登録し使用することが可能です。
• 日本法人でも、いくつかのオリジナルツールを提供しています。

-例: GSI-DEM Importツール：
• 国土地理院のDEM（基盤地図情報数値標高モデル： JPGIS(GML)形式）を複数枚結合し、ラスタ
形式でENVIに出力するツールです。

• 機能の入手方法や詳細については、support_jp@NV5.comまでご連絡ください。
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https://fgd.gsi.go.jp/download/menu.php


ENVI入門

さらに学習したい人のために

• ENVIでは、チュートリアルとして様々な演習を提供しています。
- https://www.nv5geospatialsoftware.com/docs/tutorials.html

• トレーニングデータは米国本社のサイトからダウンロードすることが可能です。（以下の図）
- https://www.nv5geospatialsoftware.com/Support/Self-Help-Tools/Tutorials
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チュートリアルデータは、
こちらのリンクをクリックすることで
ダウンロードできます。

https://www.nv5geospatialsoftware.com/docs/tutorials.html
https://www.nv5geospatialsoftware.com/Support/Self-Help-Tools/Tutorials


ENVI入門

質疑応答

•本日のトレーニングや全体を通して、疑問点があればご質問ください。

•トレーニング終了後に思いついた質問などあれば、以下の連絡先まで
ご連絡ください。
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NV5 Geospatial 製品・サポート連絡先
E-mail：
support_jp@L3Harris.com

mailto:support_jp@L3Harris.com
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